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PowerPoint Fundamentals

Microsoft PowerPoint is a presentation application that
helps you transform your ideas into professional
presentations that are convincing and informative. Understand the Screen
Whether you’re delivering annual sales statistics to a
large audience or creating a personal slide show of
your recent trip abroad, PowerPoint has all the tools Open a Presentation
you need to get your message across.

Objectives

Create a New Presentation

Save a Presentation

This module is an introduction to working with AutoRecover
PowerPoint. You’ll learn about the main parts of the Navigate a Presentation
PowerPoint screen as well as the basics for creating

and navigating a presentation. CHEQRE VIEWs

Print

The Quick Access Toolbar
Share a Presentation
Help

Close and Exit

© 2025 CustomGuide, Inc. 13



Understand the Screen

There is a lot going on with the PowerPoint program screen, so this lesson will help you become more
familiar with it.

The PowerPoint Screen

Review the labeled items in the images below, then refer to the corresponding tables to see what everything
does.

AutoSave (@ off) 7 A G T B understand-the-screen - Pow... Kayla Clz C

File Home Insert Draw Design Transitions Animationg ge Show  Review View Help O Tell me [l -

BH B = o [ @4‘9 9)
MNew Table Images | lllustrations | Forms Add Links Caomment Text Symbols | Media o

Slide = = M M ins - M

Slides Tables Farms ‘ Comments |

.Y
4 Title Slide N E

B Giving a Great

2
s . . !
e Presentation |
l CustomGuide Interactive Training \
&
s
| s
¥
4 Good vs, Bad
N .. Introduce the presentation topic and give a brief description of CustomGuide’s
. = .I outstanding services.
|_ -
slide 1 of 13 B = B T -8+ u%

PowerPoint Program Screen

o Title Bar: Displays the name of the current G Display Options: Here you can change how
file. much of the ribbon is displayed, minimize,
maximize or restore the screen, or close
PowerPoint altogether.

Quick Access Toolbar: This is a fast way to Q Ribbon: This is where you'’ll find all the
access some of the most used features. options you need to create a presentation.
The options are grouped into tabs.
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AutoSave (8 off) [E] -3 ™ s 01-understand-the-screen - Pow... Kayla Claypool

D Tell me G-
=~ | T=. lﬁv
— = 4 A
iy’

File Home Insert Draw Design Transitions Animations  Slide Show Review  Vig

X == B~ | |Calibri -2 -
(0 D

m
<

AV = 3= == . gy
Mew BIUS»3 === [ Drawing | Editing | Dictate
¥ Side~ i~ | -~ A-Aa- AN B =ZS==E= m- - - B

Clipboard Slides Fant Pl Paragraph ra Voice

[¥]
r]?

4 Title Slide

1

’ F

;Introduction T GlVIng a Great

N == Presentation |
l - CustomGuide Interactive Training I

3

i

4 Good vs, Bad @
- — Introduce the presentation topic and give a bri ription of CustomG
B ll outstanding services.

L

slide 1 of 13 B 22 FH 5 -+ 4%

PowerPoint Program Screen

G Microsoft Account User Info: Shows 0 Status Bar: Displays information about the
current user information. Click to view presentation, such as slide numbers and buttons
account options. to view notes or comments.

Slide Pane: Shows a large view of the o View Shortcuts: Quickly switches between the
selected slide. This is where edits are available View options.
made and objects are selected.

all the slides, numbered in the order clicking and dragging. Or use the + or — buttons
they'll appear. to zoom.

Notes Pane: Holds notes for the

e Thumbnails Pane: Shows thumbnails of 0 Zoom Slider: Zooms in or out of a slide by simply
0 presenter to read while presenting.
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Create a New Presentation

Creating a new presentation is one of the most basic commands you’ll need in PowerPoint. You can create a
new, blank presentation, or create a new presentation based on a variety of pre-designed templates.

Create a Blank Presentation

° C||Ck the File tab AutoSave (o) - Presentation - PowerPoint Kayla Claypool
File Home Insert Draw Design Transitions Animations Slide Show Review View Help 2 Tell me [ =
o Select New. A | SUER=- WG] [[2]] @
. . I = | BIUS= == B =N | Eciting -
o Click Blank Presentation. 3 B-|2.a pa|anlt|l==== = ! .
Clipboard & Slides Font Paragraph Voice A
Shortcut: Press Ctrl + N to
create a new, blank
presentation. O o e KaylClypool 7 — O X
< New
{01 Home
D New Qar(hfor online templates and themes Fel
d searches: P ion Education Themes Business Charts

E> Open
Diagrams  Inf s

‘ Eakeatc’ur ﬂ
N C

Blank Presentation Welcome to PowerPoint

R ﬁ \ :
&?i'ﬁ‘lageg QuickStarter
rd
-

Bring your presentations to life... Start an outline m

Account

Feedback
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Create a Presentation from a Template

Using a template allows you to begin with a presentation that has already been designed and formatted so
you can just insert the information. This saves you time and you will end up with a professionally designed
presentation.

o CliCk the File tab. * on) [J QI Presentation - PowerPaint Kayla Claypool
I File Home Insert Draw Design Transitions Animations Slide Show  Review View Help O Tell me [t =
Select New v .
. & - 24 15 Ch pel D
. QED % 8 | BIUS32 B3| Drawing | Editing D‘L::te
e Type a category in the Search TS e me | 2 A nar | x| S el B
f|e|d or Select one beneath |t Clipboard & Slides Font Paragraph Voice -
o Select a secondary template
category to further narrow the Presentation:Praer e KaylaClypool 72— O X
search. B
New
e Select a template.
e CIICk create | Search for online templates and themes el

Suggested searches:  Presentations Education Themes Business Charts
|Diagrams Infographics

Take a tour ﬂ

The presentation is downloaded and
opens in PowerPoint. You can now fill
in the placeholders. You can delete

elements of a template that you don’t | . >
need, such as extra slides, images, and Bk Presentation Welcome to PowerPaint
text.

Getstarted QuickStarter

with 3D

Account Bring your presentations to life... Start an outline m

Bl | -

Feedback

Presentation- PowerPoint Kayla Claypool ? - o X
.
< all | Business 0
E Category
Business 250
Selinga Technology 49
= Industry 2
Design Sets 30
Business sales presentation on p... Ficfass 25
Analysis 22
Marketing 21
o Paper 19
Presentations 13
Schedules 12
Lists. 17
Business direction presentation (... =] 17
Brochures 14
]
Account | Database 14 | |
'l;v‘;ca:‘n‘-;:mulng | Labels 14
Feedback by e |- }<] Sales 14
e -
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Open a Presentation

Before you can work on a presentation that you or someone else has previously created and saved, you
need to open it. You can locate a presentation on your computer and simply double-click to open it, or you
can open a presentation from within PowerPoint.

Open an Existing Presentation

o Click the File tab. PowerPoint Kayla Claypool
File Home Insert Draw Design Transitions Animations Slide Show Review View Help 2 Tell me [t =
€@ (ClickOpen asft == N [ [7]| &
A B IUSa2 == Drawing | Editing | Diceai
Shortcut: Press Ctrl + O. ¥ = A - ha ==== | - | -

Clipboard & Slides Font Paragraph Voice ~

The Open screen appears and
gives you a few ways to find a

presentation to open. PowerPaint Kayla Claypool 7 - o x
o Select the location where the Opeﬂ
file is saved. I D 1 2 Doamens
e Recent displays a list of | .
presentations that youlve R Shared with Me Name T Date modified
recent|y Opened CustomGuide E Custom Office...  12/10/2018 10:;
'a OneDrive - CustomGuide D PowerPoint 3/12/2019 %:32

e Shared with Me displays
files others have shared with
you on OneDrive or L
SharePoint Online.

@ Sites - CustomGuide

Other locations.

E‘g This PC
e OneDrive lets you browse B Addapice
through your files stored on
the cloud, if you have it. ot | 57 Bowse

o This PC lets you browse Feedback -
through your Documents
folder for files to open.

o Browse opens a dialog box,
where you can browse
through your computer’s
folders, drives, and network
shares.
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o Navigate to and double-click
the file you want to open.

The presentation opens in PowerPoint
and you can begin making edits.

® MNnan

El Open

{0} Home
<« - 4 5> ThisPC » Documents v ®|  Search Documents

[ Mew

Organize ~ New folder EE ~

3 Quick access

| ]03—0penfafpresentation
|

Authors: Instructer Guide
[ Microsoft PowerP

f@ OneDrive 6

I This PC

[ Desktop
Documents
4 Downloads
D Music

[&=] Pictures

B Videos

‘e Local Disk (C:) o,

Size: 421KB

File name: ~| [AllPowerpoint Presentations |

Account

Feedback

Iv]

ite modified

10/2078 10:

2/2019 9:32
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Save a Presentation

After you’ve created a presentation, you need to save it if you want to use it again. You can choose to save a
copy of an existing presentation under a new name, to a different location, or using a different file type. You

will also want to save periodically when you’re creating and editing a presentation to prevent any loss of

work.

Save a New Presentation

Click the Save button on the
Quick Access Toolbar.

Shortcut: Press Ctrl + S.

If this is the first time you've
saved the presentation, the
Save As screen will appear.

Choose where you want to
save your file:

e OneDrive is a cloud storage
folder accessible to all
computers and mobile
devices that you've
connected to your Office

365 account.

You can select a SharePoint
site, if you're part of an
organization that uses one.

Select This PC to save the
file locally in your
Documents folder.

Click Browse to open a
dialog box, where you can
browse through your
computer’s folders, drives,
and network shares.

Enter a file name.

The file is saved and can be safely
closed to reopen later.

Click Save.

AutoSave (8 oft) SR

Clipboard 1=

Calibri -6 -] =~
s B I US a M-

New —

Side- O~ | £ - A-Aa- A A A

Slides Font ]

1

Presentation] - PowerPoint

Draw Design Transitio Animatio Slide Shc Review Wiew Help Format

= .

Paragraph &

Drawing
£ Tell me
B~ 0 Q

-
Drawing | Editing | Dictate
- - - B

1=
=

CA

Voice

T

My Presentation

Click to add subtitle

= Notes

E

oo

oo + 45%

B2 g -

=]

Presentation] - PowerPoint

Save As
@ Recent

CustomGuide

F% OneDrive - CustomGuide

@ Sites - CustomGuide

Other locations:
[ isec
@ Add a Place
B Browse

Kayla Claypool 7

== OneDrive - CustomGuide

My Prasentatlonl

(55 save

o

Date modified

PowerPaint Presentation (.pphd ¥
Wore options...

Name T

D Attachments

D Documents

11/27/2017 %33 AM

5/31/2018 9:21 AM
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Toggle AutoSave
Notice up next to the Quick Access Toolbar, that because we saved this file online, the AutoSave feature is

automatically turned on.

Click the AutoSave toggle
button to turn the feature on

or off.

Save Progress
If you’re working with AutoSave turned off, you’ll want to manually save any changes you make periodically.

This way, you won'’t lose progress if you experience an unexpected crash.

Click the Save button on the
Quick Access Toolbar.

Shortcut: Press Ctrl + S to save
the changes in the same
location with the same file

name.

rucSave @D (5 9- Q¢ © = My Presentation- PowerPoint Drawing
File Hq 1 nsert Draw Design Transitio Animatio Slide She| Review  View |Help  Format | 2 Tell me 1= =
ﬁifx = - CBahb; — AV- 6 - T ol @J
- i -
paste New - eb“j . Drawing | Editing | Dictate
- Side~ B~ | £~ A~ har | A A A - - o
Clipboard = Slides Font I Paragraph 1 Voice ~
1
g

[ O- Q

°

Click to add subtitle

B 7 - + 45% [0

= Notes IEN -2

AutoSave (8 Gff) [CTE)~ (Mol < My Presentation- PowerPoint Drawing
File Home In Draw Design Transitio Animatio Slide Shc Review View Help Format O Tell me = =
"—"I:l A -i&v Calibri e -[li=siELE U (o 73 Q
= - P AV 5 |
e B | e @ BIUS N = " B | Drawing | Editing | Dictate
-3 Side- i | #-A-har A ALy | E=E=E= B - < B
Clipboard 1 Slides Font ) Paragraph [F] Voice ~
June 16t O
o 0
o o
= Notes B 0= B =T -1 + 45% [
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Save As a New File and/or Location

Sometimes, you may want to make a copy of an existing presentation and save it to a new location and/or

save it with a new name.

c Click the File tab. Acsave @D [ 9 @ T
File

Home Insert Draw Design Transitio Animatio Slide Shc Review View Help Format

Drawing

O Tell me [t =

o Click Save As. X | o B | m ol (o] &
. B | o & | BITUS @& Drawing | Editing DchItaJte
e Select a location. S | S B | 2-A-aa | & o | g | e
Clipboard 1 Slides Font r,. Paragraph & Vioice -
o Enter a new File name.
o Click Save.
My Presentation- PowerPoint Kayla Claypool ? o a x

Save As
@ Recent

The presentation is saved in the new
location with the new name. The
original file is automatically closed, and

[> OneDrive - CustomGuide

| My Presentation |

[]

you can start working on the new one

I CustomGuide

X OneDrive - CustomGuide

right away.

@ Sites - CustomGuide

Other locations.
E‘g This PC
@ Add a Place

[ Browse

vH [F,ESEVE ‘

| PowerPoint Presentation (*.pptx)

More options...

Name T Date modified

E Attachments

D Documents

11/27/2017 %33 AM

5/31/2018 9:21 AM

® S A

m Save As
(nj Home P v 4 W > ThisPC » Desktop
[ Mew Organise v New folder

~

= Open > ¥ Quick access

> [ Microsoft PowerP
» @ OneDrive
~ O This PC

> [ Desktop

> Documents

> b Downloads
> B Movies v

v O Search Desktop pel

File name: | New Presentation|

Save as type: | PowerPoint Presentation

 Hide Folders

Tags: Add atag

Tools ~ Save

]
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Save to Different File Formats

PowerPoint files are normally saved as PowerPoint Presentations, but you can save the information to other
file formats as well. For example, you may want to save your file as a PDF so someone who doesn't have
PowerPoint can view the presentation.

c Click the File tab. AutoSave (8 om) D-Q¢ W = New Presentation - Saved to this PC Drawing
File Home Insert  Draw Design Transitio Animatio Slide Shc Review View Help Format = 2 Tell me [t =
e Click Save As. g \j e e - 3l |[o]] &
0 - B I U S a - - ==
New Drawing | Editing | Dictate
e Choose where you want to =R e B L R T = T bl el
save yOUr f||e Clipboard 15 Slides Font B Paragraph L Voice ~
o (Optional) Enter a new File
name New Presentation- Saved to this PC Kayla Claypool 7 = o X
e Click the Save as type list Save As
arrow. /]\ = Documents
@ Recent
Y h t Mew Presentation
Oou can choose to save your ——— ,,m,,,omt,,mm,wpm - | [,E"SM
presentation as any of the file _ _ PowsPaint Presentation (pi)
. A 6 OneDrive - CustomGuide PowerPoint Macro-Enabled Presentation (*.pptm)
types in the drop-down list. PowerPoint 97-2003 Presentation (*.ppt)
PDF (*.pdf)
. Sites - CustomGuide ESibocumentliEips)
o Select a file format. s 2 bowepoint Tamplate *po)
PowerPoint Macro-Enabled Template (*.potm)
. Other locations PowerPoint 97-2003 Template (*.pot)
Click Save.
= (Office Theme (*.thmx)
o [l isec o PowerPaint Show (" ppsd
PowerPoint Macro-Enabled Show (*ppsm)
@ Add a Place PowerPoint 97-2003 Show (*.pps)
PowerPoint Add-in (*.ppam)
PowerPoint 97-2003 Add-in (*.ppa)
B Browse PowerPoint XML Presentation (*.xml)
| MPEG-4 Video (*.mpd)
IWmdows Metafile (*.wmf) [ |
[ NELTA] Aadafile i+ £ “
A4 0]

Commn e romas
N

PowerPoint Presentation (.pptx) This is the default format for PowerPoint presentations.

PowerPoint Macro-Enabled
Presentation (.potm)

PowerPoint 97-2003
Presentation (.ppt)

PDF (.pdf)

PowerPoint Show (.ppsx)

Video Formats (.mp4 or .wmv)

This is a version of the default PowerPoint file type that supports
macros, which allow for small tasks to be automated.

Presentations in this format can be read by all previous versions of
PowerPoint but lack some advanced features. They are also larger
than .pptx files and more prone to corruption.

A PDF preserves a presentation as it would appear when printed.
PDFs, when shared electronically, can be viewed on many kinds of
devices. The PowerPoint software is not needed to view a PDF
presentation.

This is a read-only presentation file. When you double-click a .ppsx
file, the presentation is automatically launched. You don’t need to
first open PowerPoint.

These formats save a presentation as a video that can be viewed
without having PowerPoint installed. MP4 is an international format
that’s broadly supported; WMV files can only be viewed in Windows.
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AutoRecover

Computers don’t always work the way they’re supposed to. Nothing is more frustrating than when a
program locks up and stops responding, or worse, completely crashes—especially if you lose progress on an
important presentation that you’re working on.

Fortunately, Microsoft realizes that people might want to recover their presentations when something
catastrophic happens. If PowerPoint 2019 encounters a problem and stops responding, you can restart
PowerPoint or your computer and try to recover your lost presentations.

Recover a Presentation

o Following a crash, restart e KelaCoyposl 2 — O %
PowerPoint. PowerPoint Good morning :
If an unsaved presentation can
be recovered, a Recover N
unsaved presentations heading fereaon with 30
will appear on the Welcome L G
Blank Presentation Welcome to PowerP... 57 Bring your presentati... 57

screen.

e Click Recover unsaved
presentations.

More themes —>

Recent  Pinned Shared with Me

‘You haven't opened any presentations recently. Click Open to browse for a presentation.

The Recovery pane appears,
listing all recovered
presentations that were found.

Recover unsaved presentations More presentations —>

Account

e Select the presentation from
the Document Recovery pane.

Feedback

Options

The last autosaved version of
that presentation opens.

o Click Close. AlifaSave Presentation - PowerPoint Kayla Claypool

File Home Insert Draw Design Transitions Animations Slide Show Review View Help 2 Tellme [t =

The Recovery pane closes, and fﬁ[_'@ @- ==k | 5] |[2]| B
&) o

4
UL

you can get back to work. Paste New _ L ) == S Drawing | Editing | Dictate
- Side- O~ | £ - A-Aa- A A& A === B S S -
Clipboard | Slides Font Paragraph Voice

Dk

Document Recovery Title Slide

a
1
PawerPaint has recovered the fallowing *

files. Save the ones you wish to keep.

4 Introduct..

@ Presentation.ppbx [Originall 2
Version created last time the... * | -
31272019 11:31 AM Giving a Great

6 g )| Presentation
L CustemGa i ieraxtive Tranig

&

@
=]
“ B

5
E 4
6
(Z) Which file do | want to save? : =

* | = Introduce the presentation topic and give a brief
Close description of CustomGuide's outstanding services.
7 u -
Slide 1 of 13 B =5 B ¥ -4 + 28%
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AutoRecovery Settings

You can further protect your work by using the AutoRecover feature to periodically save a temporary copy
of the presentation you're working on. To recover work after a software failure, you must have turned on
the AutoRecover feature before the problem occurred. You can set the AutoRecover save interval to occur
more frequently than its default setting of every 10 minutes.

o Click the File tab. AutoSave (& 0F) 5. Qo - Presentation - PowerPaint Kayla Claypool
. ) File Home Insert Draw Design Transitions Animations Slide Show  Review View Help O Tell me [t =
e Click OpthﬂS. X 4@ B-  calibri -l - Ch 0 D
. @ New D B I US a2 T B D‘L::te
e Click Save. © F Side- B LA nar | A AT B . . .
Clipboard 15 Slides Font B Paragraph ® Voice ~
o Make sure the Save
AutoRecover information
check box is checked. Presentsticn povern I8 KoylaClaypesl 2 — O X
e Adjust the time interval. Info
Tip: You can’t specify the Presentation
interval if the check box is not ”E‘“"“j | | I
&> Upload ﬁ Share @ Co ath [ Open file location
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e Click OK.
IE Pratect Presentation Properties
Even with PowerPoint’s recovery e e e s T
Presentation ~ resentation. Slides 13
features, the best way to ensure that - preseme R,
you don’t lose much progress is to save _ Tl PowerPoint Present
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your work regularly. @ Befare publishing this file, be aware Categories Add a category
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Close

Options
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" Embedded documents
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disabilities are unable to read
Related Pennls

PowerPoint Options
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Proofing

1 Save
Language
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Add-ins
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Customize how documents are saved.
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AutoSave OneDrive and SharePoint Online files by default on PowerPoint &

Save files in this format: PowerPoint Presentation i
Save AutoRecover information every s
Keep the last AutoRecovered version if | close without saving
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AutoRecover file location:

[ Don't show the Backstage when opening or saving files with keyboard shortcuts
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Navigate a Presentation

Since each presentation is a series of slides, being able to navigate between those slides is pretty important.
The Thumbnails pane shows little pictures of all the slides, with the selected slide outlined in orange.

Navigate a Presentation

a Select a slide in the Thumbnails AutoSave (8_0fF) - Qo o= D6-navigate-a-presentation * Pows.. Kayla Claypool
File Home Insert Draw Design Transitions Animations Slide Show Review View Help O Tell me [ =

pane to work with it in the Liome] - -

Slide pane. Click other d Ba |55 rsanm s SEVRIEIRN |
. . Paste New - A Drawing | Editing | Dictate

thumbnails to change which I s | 2-A-Aa | AN A o |
Font ] Paragraph [Fl Voice

Slides

Clipboard =

slide you're editing.

[ D]?

4 Title Slide

Once a slide is selected, click an image,
graphic, or textbox on the slide to edit
it.

Giving a Great
Presentation

CustomGuide Interactive Training

Navigate Using the Keyboard
You can also move around a presentation with the keyboard, using the methods described in the table
below.

Navigation Keystrokes

Arrow Keys (TN €-) Move up or down to another slide or section.
Ctrl + Home Jump to the first slide.

Ctrl + End Jump to the last slide.

Page Up Jump to the next slide up.

Page Down Jump to the next slide down.
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Change Views

There are several ways to change how a presentation’s contents are displayed on the screen using the
preset views. You can also zoom in or out to see more details of the slide.

Change the Presentation View

o Click the View tab. AutaSave (8 0f) - Q@ E s 07-change-views - Pow... Kayla Claypool [
. Fle _Home Insert Draw Design Transitions Animations | Slide Show | Review View Help O Tellme Eaa=
o Select a view. B i soter :@ZM“:, | Q o ﬁ ol | &
e Normal: Displays the full o %L:TZEW Bl el | o | e, (GO e | v
slide, the thumbnails, and fommeder ] Mesterien Zer — -
the ribbon. 2 esin
b
e Outline View: Displays an ’ - ‘ What Makes a Bad Presentation?
outline of the presentation’s
contents at the left. It makes | ; ot o
it easy to focus on your text | * T
without graphics. | ‘ \ -
o Slide Sorter: Gives you an : ‘
at-a-glance view of all your 1 ‘
slides, which is convenient 4 Goodvs, Bad ;
for rearranging them. Click 4 Iﬁl . :
and drag the slides to ] SEN e

reorder them.

¢ Notes Page: Shows how the
presentation will look when
printed with notes. Each
page will have one slide and
its speaker notes, which can
be formatted in this view.

o Reading View: This is a full-
screen view. Use it if you
want to scan the
presentation content
without making any edits.

Tip: You can quickly access the
Normal, Slide Sorter, Reading,
and Slide Show views from the
status bar.
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Print

Once you have created a presentation, and your computer is connected to a printer, you can print a copy.

Before you do this, it’s a good idea to preview how it’s going to look.

Click the File tab.

Select Print.
Shortcut: Press Ctrl + P.

Examine the print preview on
the right side of the screen,
making sure that the preview
looks the way you want it.

Select the correct printer by
clicking the Printer list arrow
and selecting it from the list.

AutoSave (@ off) O Q ®m s 08-print - PowerPoint Kayla Claypool
File Home Insert Draw Design Transitions Animations Slide Show Review View Help 2 Tell me [t =
X —Eﬂ] - | calibri 2 -l E-EEB | 0 0
e} i B I UGS a2V, = = | = Eal =2
MNew = = - — o Drawing | Editing | Dictate
- F SiderT- | £-A-A AN K| E=EEE B < - -
Clipboard = Slides Font I Paragraph 51 Voice ~
Kayla Claypool ~ ? - O 4

08-print - PowerPoint

Print
J'8]~"0
Print

]

Printer

HP Deskjet F4100 series
1
™ O

Adjust the printer settings
using the options below the

: f : rinter Broperties Cunga i
printer, described in the table ——— Freseniaion
below Settings

g Custom Range |
. Enter specific slides to print
o Choose the number of copies o~

in the Copies text field.

E 25lides
Handotits (2 slides per page)

2 5.

Click Print.

Account

Feedback

Print Range Print the whole presentation, a selection, a certain slide range, a single slide, or a
custom range.

Determine what you want to print on each page. You can print a single slide, multiple
sides, slide notes, handouts, and more.

Print Layout

Coliate Collating prints multiple copies of the presentation all the way through (1, 2, 3; 1, 2,
3), while printing uncollated prints multiple copies of each slide together (1, 1; 2, 2; 3,
3).

Color Select whether to print the presentation in full color, grayscale, or pure black and

white.
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The Quick Access Toolbar

The Quick Access Toolbar holds a few buttons for commands that you'll use often, such as Save, Undo, and

Redo. They'll always be available, no matter which ribbon tab is active.

Add a Button to the Quick Access Toolbar

If the Quick Access Toolbar doesn’t contain enough of your frequently used commands, you can customize it

by adding or removing commands.

u Click the Customize Quick
Access Toolbar button.

A list appears and displays
some commands you can add.
You can find all the available
commands to add by selecting
More Commands, which opens
the PowerPoint Options dialog
box.

e Select the command you want
to add.

Remove a Button from the Quick Access Toolbar

o Right-click the button you want
to remove.

e Select Remove from Quick
Access Toolbar.

AutoSave (® 5 92-¢

= -quick-access-.. - PowerPoint Kayla Cla:

Fle ~ Home Insert Draw Design Customize Quick Access Toolbarshow Review View Help 2 Tellme

y = &~ | [calibr I" Automatically Save = 15 o o
md |me - E: 3 0
MNew

. -

Paste 23 = ; IAL Open = _ . PEI || BT | Ozt
- Side~ O~ < == = i i :
Clipboard 1 Slides 0! v remeErsin 5 W

T] Email
4 Title Slide Quick Print

4 Good vs. Bad

X = [ Y s

Show Below the Ribbon

Print Preview and Print
Spelling

¥ Undo

« Redo

v Start From Beginning

[ Q)
Touch/Mouse Mode 3|V|ng a Great
| Presentation’

O CisiomGuute Interacive Tramning

= Notes B 05 B 5T -—b——+ 35% [

AutaSave

D) MG | S 09-the-quick-access-—.. Kayla Claypool

Remove from Quick Access Toolbar

File Home Insert Draw Design Transiti 2 2 Tellme
Customize Quick Access Toolbar...
Jﬁ B- | calibri Jo) 0
DED - 8 7 U 5 ShowQuickAccess Toolbar Below the Ribbon ]
Paste New  — - Customize the Ribhon... Editing | Dictate
v F | side- T~ | £ - A~ Aa- - =
Collapse the Ribbon
Clipboard Slides Font I Voice
4 Title Slide
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Share a Presentation

It's easy to share a presentation with other people from within PowerPoint. For example, you can send a
sharing invitation to co-workers that gives them access to view or edit the file. To share your presentation,
make sure it’s saved to an online location, such as your OneDrive or your organization’s SharePoint server.

Share a Presentation

Save your presentation to an
online location.

Click the Share button.

The Share window opens,
where you can invite others to

view and edit the presentation.

Enter an email address.
Click the Link settings button.

Here you can control who this
link you send out will work
for—anyone with the link,
anyone in your organization,
anyone you've already shared
it with, or just the specific
people you choose to send it
to.

Select who can view the link.

Select whether to allow
editing.

Click Apply.

AutoSave @ 0F) [ ©-7) I s

File Home Insert Draw Design Transitions Animations & Slide Show = Review View  Help

10-share-a-presentati... - PowerPoint

x_—f- =8-
ﬁil[@ IE‘ a8

Paste _
- | side- O-

Clipboard Slides

4 Title Slide

1
e
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4 Introduction

n'l

4 Good vs. Bad

X

Send Link

People in CustomGuide with the link
«can edit
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Add a message (optional)
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Kayla Claypool
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Paste New
- Slide~ [ ~
Clipboard & Slides
4 Title Slide ’

Link settings

Who would you like this link to work for?
Learn more

x

Anyone with the link @

People in CustomGuide with ~
the link

People with existing access

Specific people

Other settings

3
* P B Allow editing
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o |nc|ude a message (Optlonal) AutaSave (8 0f) [ -7y ® = 10-share-a-presentati... - PowerPoint Kayla Claypool
h ” b I File Home Insert Draw Design Transitions Animations = Slide Show Review View Help 2 Tellme = =
This message will be included . !
| message WIT 5€ ¢ it |3 <13 ] 2]] &
in the invitation, informing the paste 1B = Drawing | Editing | Dictate
o , . -8 Slide~ O - Send Link e - - i
reCIpIentS that you re Sharlng a Clipboard 1 Slides [F] Voice ~
presentation with them. 4 Title Slide I Pecple in CustomGuide with the link E
If you just want to copy the G
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the email in Outlook, you can o Wit Atd a message (options)
do that with these buttons ; a Great

here 4 ERO pratien
o Click Send. E ] > @

@ Click Close. | CopyLine Ouook
4 Good vs. Bad

4

The presentation is shared, and the e ‘
recipient can view the document by e = YR S R e ——a

clicking the link they've received.

[ SendaCopy ~

10-share-a-presentati... - PowerPoint  Kayla Claypool
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Manage Access to a Presentation

After you've started sharing things with others, it may be tricky to remember who has access to what.

Click the Share button.

Click the More Options (--+)
button.

Select Manage Access.

Now, you can see who has
access to this presentation,
and whether they have editing
or view-only permissions.

Click a permissions list arrow.

@
@
@

The permissions are updated.

Select a permission level.

Click Close.

e

AutoSave (@ o) [ - ) 0T

10-share-a-presentati... - PowerPoint
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Help

When you don’t know how to do something in PowerPoint, you can look up your question with the Help
feature. Help can answer your questions, offer tips, and provide guidance for all of PowerPoint’s features.

The Tell Me Field

The Tell Me field is a text field above the ribbon, where you can search for commands and get quick access

to them.

Click the Tell Me field.
Type what you want to do.

A menu appears, listing
commands related to what you
searched for, as well as a link
to that topic’s help file.

Select the command you are
looking for.

AutoSave (8 off) - mos 11-help - PowerPaint

File Home Insert Draw Design Transitions Animations = Slide Show Re

bt = @3-
fﬁr@ H

Calibri

B I U S ab - Hide Background Graphics

Paste New —
-F Side- O+ | € - A-har AN A Hide Slide
Clipboard Slides Font [} Show/Hide Grid

=]
4 Title Slide

1
* Help
g— (@) Get Help on "hide" r
£ Get more results

Smart Lookup on "hide"
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The Help Pane

If you're looking for more information about a topic, you can consult the Help files.

o Click the He|p tab. AutaSave (8 0f) D@ E s 11-help - PowerPaint Kayla Claypool [ -

File Home Insert Draw Design Transitions Animations @ Slide Show Review  View HLIp P Tellme [ =
o Click the Help button. @De O g L ﬂ
Help G Feedback Sh What"
Shortcut: Press F1. 2 oot Timing Newr
Help ~
A browser window opens to =]
4 Tit.. He‘p - x
the Microsoft Office Support v O
page. 4 Inte. & ---  Transitions L e
2 [T — ~—
e Type a help topic and click the | Results for "Transitions
Search button. 4 Go... Add, change, or remove transitions between slides -
4 [ Gi';rmg a Great Office ...
. resentation
Select a help t0p|c. 5 1 T A Slide transitions are the animation-like effects that occur when
you move from one slide to the next during a presentation. You
6 [ + | can control the speed, add sound, and customize the properties of
Information is dISp|ay6d l‘egal’dlng the L= Video: Add transitions between slides
tOpIC you ChOSE 8 1 Slide transitions are the animation-like effects that happen when
* 9 =1 ~| | you move from one slide to the next during a presentation. Add
4 | | slide transitions to bring your presentation to life. Select the slide
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Close and Exit

When you're done working with a file, it's a good idea to close it so you don't bog down your computer with
unused programs.

Close a Presentation

Each presentation window must be closed individually. If you only have one file open you can close it and
keep PowerPoint running from the File menu.

o Click the File Tab. AutaSave (8 0F) . @ ™ = 12-close-and-eiit - PowetBoint Kayla Claypool
I k File Home Insert Draw Design Transitions Animations Slide Show Review View Help 2O Tell me [ =
Click Close. i . ST
(2 BRI T ===t 6] (o] g
IE] New Reuse g b us - ] Drawing | Editing | Dictate
Note: If you have not saved the T | s eS| £ Aa ==== = | - S
presentation Since maklng Clipboard 1 Slides Font Paragraph Voice A
changes, a dialog box will
appear asking if you want to
pp g y 12-close-and-exit - PowerPoint Kayla Claypeol ? - O *
save changes to the -
presentation. Click Save if you Info
w]sh to s?ve you‘r changes; P ation
click Don’t Save if you do not Desktop
Want to save your Cha nges; o Upload |& Share @ Copy path | | = Open file location
click Cancel if you do not want
to close the presentation.
E' Protect Presentation Properties ~
. .. . B Control what types of changes -
The file is closed but PowerPoint is still h Proiec” QA PR con makc ot .- L
) ) - resentation = | presentation. e
running. You can still browse for a file Hiddensides 0
. Title PowerPaint Present
to open, create a new presentatlon, @ Inspect Presentation Tags Add atag
and access Powerp()lnt’s Optlons Befare publishing this file, be aware Categories Add a category
Check for that it contains:
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cropped out image data Last Modified
®  Presentation notes Tl
" Embedded documents
® Content that peoplewith e A
disabilities are unable to read
Ralated Pannla h
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Close PowerPoint

If you click the Close button on the title bar when you have only one PowerPoint presentation open, the

presentation will close and you will exit the PowerPoint program.

Click the Close button.

PowerPoint quits and the window
closes.
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